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This entry is from the Siemens Industry Online Support. The general terms of use 
(http://www.siemens.com/terms_of_use) apply. 

 

Security 
Informa-
tion 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber 
threats, it is necessary to implement – and continuously maintain – a holistic, 
state-of-the-art industrial security concept. Siemens’ products and solutions only 
form one element of such a concept. 
The customer is responsible to prevent unauthorized access to its plants, 
systems, machines and networks. Systems, machines and components should 
only be connected to the enterprise network or the internet if and to the extent 
necessary and with appropriate security measures (e.g. use of firewalls and 
network segmentation) in place.  
Additionally, Siemens’ guidance on appropriate security measures should be 
taken into account. For more information about industrial security, please visit 
http://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends to apply product updates as soon as available and 
to always use the latest product versions. Use of product versions that are no longer 
supported, and failure to apply latest updates may increase the customer’s exposure to 
cyber threats. 
To stay informed about product updates, subscribe to the Siemens Industrial Security 
RSS Feed under http://www.siemens.com/industrialsecurity. 

 

 

 

 

Contents 
1 Overview of Options and Licenses .................................................................. 4 

1.1 WinCC V14 ........................................................................................... 4 
1.2 WinCC V14 SP1 ................................................................................... 5 
1.3 WinCC V15 ........................................................................................... 6 

2 General Information about Licenses ............................................................... 7 

2.1 License, Certificate of License and License Key ................................. 7 
2.2 What Are Licenses Required For? ....................................................... 7 
2.3 Available License Types....................................................................... 8 
2.4 Online Software Delivery ...................................................................... 9 

3 Transferring Licenses ..................................................................................... 10 

3.1 Which Software is Required? ............................................................. 10 
3.2 How Do You Transfer License Keys? ................................................ 10 
3.3 Transfer License Keys to an Operator Panel ..................................... 10 
3.4 Transferring License Keys Back from an Operator Panel .................. 13 

4 License Key (License) Backup ....................................................................... 14 

4.1 Which Software is Required? ............................................................. 14 
4.2 When Do You Have to Backup License Keys? .................................. 14 
4.3 Backup and Restore on an Operator Panel ....................................... 14 

5 Upgrading Licenses ........................................................................................ 15 

5.1 Requirements for an Upgrade ............................................................ 15 

http://www.siemens.com/terms_of_use
http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity


 

 

Lizenzen 
Entry ID: 74796111,    V2-0,    09/2018   3 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

5.2 Upgrading Using the ALM .................................................................. 15 

6 Tips and Tricks ................................................................................................ 17 

7 SIMATIC WinCC (TIA Portal) Options ............................................................ 18 

 

 

 

 

 



1 Overview of Options and Licenses 

 

Lizenzen 
Entry ID: 74796111,    V2-0,    09/2018   4 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
1

8
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

1 Overview of Options and Licenses 
The following tables show which options of which hardware are supported 
depending on the WinCC (TIA Portal) version used and for which options licenses 
are required.  

Legend 
 — —  Option is not supported  

 X | O  Option is supported  |  License not required  

 X | X  Option is supported  |  License required  

 *)  See footnote  

1.1 WinCC V14 

Table 1-1 

No. Option Basic 
Panel 

Comfort 
Panels 

WinCC RT 
Advanced 

WinCC RT 
Professional 

1.  SIMATIC ProDiag — — X | X X | X X | X 

2.  SIMATIC Logon — — X | X 1 X | X 2 X | X 3 

3.  WinCC Logging X | O X | O X | X X | X 

4.  WinCC Recipes X | O X | O X | X X | X 

5.  WinCC Audit — — X | X X | X 4 — — 

6.  WinCC Sm@rtServer X | X X | O X | X — — 

7.  WinCC Data Monitor — — — — — — X | X 

8.  WinCC Industrial Data 
Bridge 

— — — — — — X | X 

9.  SIMATIC  
Information Server 

— — — — — — X | X 

10.  SIMATIC  
Process Historian 

— — — — — — X | X 

11.  WinCC Redundancy — — — — — — X | X 

12.  WinCC Server/ 
WinCC Client 

— — — — — — X | X 

13.  WinCC  
WebNavigator 

— —  — — X | X 

14.  WinCC WebUX — — — — — — X | X 

 

 

Note The options are described in chapter 7 "SIMATIC WinCC (TIA Portal) Options". 

 

 

                                                      
1 A SIMATIC Logon Remote Access license is required in addition  
2 A SIMATIC Logon Remote Access license is required in addition  
3 License is included in the scope of delivery. A SIMATIC Remote Access license is not required  
4 A SIMATIC WinCC Logging license is required in addition 
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1.2 WinCC V14 SP1 

Table 1-2 

No. Option Basic 
Panel 

Comfort 
Panels 

WinCC RT 
Advanced 

WinCC RT 
Professional 

1.  SIMATIC ProDiag — — X | X X | X X | X 

2.  SIMATIC Logon — — X | X 5 X | X 6 X | X 7 

3.  WinCC Logging X | O X | O X | X X | X 

4.  WinCC Recipes X | O X | O X | X X | X 

5.  WinCC Audit — — X | X X | X 8 — — 

6.  WinCC Sm@rtServer X | X X | O X | O — — 

7.  WinCC Data Monitor — — — — — — X | X 

8.  WinCC Industrial Data 
Bridge 

— — — — — — X | X 

9.  SIMATIC  
Information Server 

— — — — — — X | X 

10.  SIMATIC  
Process Historian 

— — — — — — X | X 

11.  WinCC Redundancy — — — — — — X | X 

12.  WinCC Server/ 
WinCC Client 

— — — — — — X | X 

13.  WinCC  
WebNavigator 

— —  — — X | X 

14.  WinCC WebUX — — — — — — X | X 

 

 

Note The options are described in chapter 7 "SIMATIC WinCC (TIA Portal) Options". 

 

 

 

                                                      
5 A SIMATIC Logon Remote Access license is required in addition  
6 A SIMATIC Logon Remote Access license is required in addition  
7 License is included in the scope of delivery. A SIMATIC Remote Access license is not required  
8 A SIMATIC WinCC Logging license is required in addition 
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1.3 WinCC V15  

Table 1-3 

No. Option Basic 
Panel 

Comfort 
Panels 

WinCC RT 
Advanced 

WinCC RT 
Professional 

1.  SIMATIC ProDiag — — X | X X | X X | X 

2.  SIMATIC Logon — — X | X 9 X | X 10 X | X 11 

3.  WinCC Logging X | O X | O X | X X | X 

4.  WinCC Recipes X | O X | O X | X X | X 

5.  WinCC Audit — — X | X X | X 12 — — 

6.  WinCC Sm@rtServer X | X X | O X | O — — 

7.  WinCC Data Monitor — — — — — — X | X 

8.  WinCC Industrial Data 
Bridge 

— — — — — — X | X 

9.  SIMATIC  
Information Server 

— — — — — — X | X 

10.  SIMATIC  
Process Historian 

— — — — — — X | X 

11.  WinCC Redundancy — — — — — — X | X 

12.  WinCC Server/ 
WinCC Client 

— — — — — — X | X 

13.  WinCC  
WebNavigator 

— —  — — X | X 

14.  WinCC WebUX — — — — — — X | X 

 

 

Note The options are described in chapter 7 "SIMATIC WinCC (TIA Portal) Options". 

 

 

 

 

                                                      
9 A SIMATIC Logon Remote Access license is required in addition  
10 A SIMATIC Logon Remote Access license is required in addition  
11 License is included in the scope of delivery. A SIMATIC Remote Access license is not 
required  
12 A SIMATIC WinCC Logging license is required in addition 
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2 General Information about Licenses 

2.1 License, Certificate of License and License Key 

Below are explanations of the terms used.  

• License  
A license is granted as the authorization to utilize products. A license consists 
of the CoL and the license key, which represent the authorization for utilization. 

• CoL - Certificate of License: 
The CoL is a confirmation in writing (evidence) of the license.  
It documents the owner of the license in the legal sense and contains the 
license number for unique identification of the license. 

• License Key:  
The license key is the "technical representation" of the license ("electronic 
license stamp").  

• Authorization:  
The authorization is the predecessor of the license key.  
Authorizations are not used any more in WinCC (TIA Portal). This is why the 
topic of "Authorization" will not be dealt with any further. Information about this 
is available in Entry ID: 27005215.  

 

Note CoL: 
You receive the license in paper form. The license authorizes you to install on a 
computer and use the version of WinCC (TIA Portal) purchased.  

License Key: 
You receive the license key on a separate, copy-protected USB stick. 

 

2.2 What Are Licenses Required For? 

You need a license key in the following cases:  

• To use the WinCC (TIA Portal) Engineering System.  

• To use the options of the WinCC (TIA Portal) Engineering System. 

• To use the WinCC (TIA Portal) Runtime.  

• To use options of WinCC (TIA Portal) Runtime on PC-based operator panels. 

• To use options on non-PC-based operator panels. 

 

https://support.industry.siemens.com/cs/ww/en/view/27005215
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2.3 Available License Types 

The WinCC (TIA Portal) Engineering System uses the following license types.  

• Demo License  

• Floating License 

• Trial License 

• Single License  

• Upgrade License  

• Power Pack  

• Unlock Copy License (UCL)  

Descriptions of the license types 

• Demo License 
Utilization of the software with this license is limited to  

–  The number of operating hours specified in the contract. 

–  The number of days from first use specified in the contract. 

–  Up to the expiry date specified in the contract. 

 

• Floating License  

–  Standard license for WinCC (TIA Portal) Engineering System. 

– The license has no time limit.  

–  You can use this license locally or through the network on any computer. 

–  Can be upgraded.  

 

• Trial License  

–  One-off, limited duration standard license. 

–  You can install and use this license locally on any computer. 

 

• Single License  

–  All licenses for WinCC (TIA Portal) Runtime and Runtime options are 
"Single Licenses". The license has no time limit and can only be installed 
and used locally.  

–  Can be upgraded. 

 

• Upgrade License  
With the Upgrade License you can do the following, for example: 

–  Switch from an old version to a new version  
(the requirement here is that the new version is already installed). 

–  Extend the quantity framework.  
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• Power Pack 
Power Pack permits you to make the following upgrades: 

– From a smaller to a greater edition of WinCC Engineering System. 

–  To a Runtime system with a larger quantity framework.  

For this a Power Pack includes a special license for switching to utilization of a 
higher level of WinCC.  

 

• Unlock Copy License (UCL) 

–  The UCL is an add-on based on standard products (with authorization) 
which replaces the authorization query of copy-protected programs with a 
customer-specific entry; the UCL therefore overrides the copy protection.  

–  The customer-specific entry is displayed in a splash screen each time the 
software is started and can also be read out from "Help/Info". 

–  The UCL is a customer-specific production.  

 

2.4 Online Software Delivery  

Online Software Delivery – by download to the automation software. 

Entry ID: 109479521 provides information on the topic of  
"Downloading automation software and licenses".  

 

 

 

https://support.industry.siemens.com/cs/ww/en/view/109479521
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3 Transferring Licenses 

3.1 Which Software is Required? 

The Automation License Manager (ALM) software is required for handling the 
license keys.   

The Automation License Manager is installed automatically by default with the 
software. Alternatively you can download the software in  
Entry ID: 114358 . 

 

3.2 How Do You Transfer License Keys? 

The Automation License Manager provides the following options for transferring 
license keys: 

1. Drag and drop. 

2. Cut and paste. 

3. Menu command "License Keys > Transfer“ 

 

A description of which transfer and connection options are available for the 
operator panels is given in Entry ID: 19109408. 
 

3.3 Transfer License Keys to an Operator Panel  

You can find out below how to transfer a license key from a PC to a TP1200 
Comfort Panel, by way of example. The connection type depends on the operator 
panel you are using. 

Table 3-1 

No. Description 

1.  Connect operator panel with the configuration computer  

 

Use a cable corresponding to the selected transfer type to connect the operator 
panel to the configuration computer.  

In this example it is an Ethernet cable. 

2.  Settings on the operator panel  

 

• Set the relevant transfer type on the operator panel. This must match the 
settings in the ALM described below. Here you must pay attention above all 
to the settings on the Comfort Panel, for example. Transfer type "PN/IE" ➔ 
"Ethernet" selected? (link).  

• Then set the operator panel to Transfer Mode. 

3.  Open the Automation License Manager (Windows 7 Professional) 

 

Open the Automation License Manager via  

"Start > Programs > Siemens Automation > Automation License Manager". 

https://support.industry.siemens.com/cs/ww/en/view/114358
https://support.industry.siemens.com/cs/ww/en/view/19109408
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No. Description 

4.  Connect the operator panel with the Automation License Manager 

 

• Select the menu command  
"View > Administration". 

• Go to  
"Edit > Connect Target System > Connect Panel" to get to the "Connect 
Target System" menu. 

 

5.  "Connect Target System" menu screen 

 

• Device type: 
Here you select the relevant operator panel. In this case the "TP1200 
Comfort".  

• Connection: 
In the drop-down list box you select the connection type. In this example it is 
"Ethernet". Make sure that the transfer setting matches the target device 
(link).  

• Computer name (IP address): 
Specify the operator panel's "IP address" here. In this case "172.16.34.200".  

• Click "OK" to confirm the settings. Clicking the "OK" button establishes a 
connection between the ALM and the operator panel.  

 

 

 

Note: 
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No. Description 

When the connection to the operator panel has been established, the operator 
panel is displayed in the navigation area. If this is not the case, then please refer 
to the information in Entry ID: 88633853 . 

 

 

6.  Display available licenses  

 

• Mark the drive where the license is located. In this example drive "C:\".  

• In the Object area on the right you have a display of all the available licenses 
on drive "C:\". 

 

https://support.industry.siemens.com/cs/ww/en/view/88633853
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No. Description 

7.  Transfer licenses 

 

• In the Object area you mark one or all the licenses that you wish to transfer 
to the operator panel.  

• Drag-and-drop the marked license to the operator panel displayed in the 
navigation area. The license is transferred to the operator panel. 

 

8.  Overview of licenses available on the operator panel 

 

To check, you mark the operator panel in the navigation area.  

In the Object area on the right you get a display of the license just copied. This 
concludes the license transfer. 

You can close the ALM again. 

 

 

3.4 Transferring License Keys Back from an Operator 
Panel 

The procedure is identical to that described previously in section 3.2 "How Do You 
Transfer License Keys?".  

The difference is in table section no. "7".  

• In the Object area you mark one or all the licenses that you wish to remove 
from the operator panel.  

• Drag-and-drop the marked licenses to the drive in the navigation area where 
the licenses are to be stored. The licenses are transferred from the operator 
panel to the drive. 
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4 License Key (License) Backup  

4.1 Which Software is Required? 

You can use the Automation License Manager (ALM) to backup license keys for 
software and operator panels. Follow the instructions in section 3.4 "Transferring 
License Keys Back from an Operator Panel" to backup the license keys of an 
operator panel.  

 

4.2 When Do You Have to Backup License Keys? 

You must save the license keys under the following circumstances:  

• When you install a new operating system on a PC.  

• Before you format the hard disk on a PC.  

• Before you compress the hard disk on a PC.  

• Before you restore the hard disk on a PC.  

• When you start an optimization program that moves fixed blocks on a PC.  

• Before you run a backup / restore procedure on an operator panel.  

• Before you do a "Reset to factory settings" on an operator panel.  

 

4.3 Backup and Restore on an Operator Panel  

You do a backup or restore on an operator panel  

• With ProSave  

• Directly on the operator panel 

 

With a backup you can do a complete save including licenses and use "Restore" to 
transfer them back again to the operator panel.  

How to do a backup and restore is described in Entry ID: 28928853 and in Entry 
ID: 58876345 (Comfort Panel). 

 

 

 

https://support.industry.siemens.com/cs/ww/en/view/28928853
https://support.industry.siemens.com/cs/ww/en/view/58876345
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5 Upgrading Licenses 
If you need to upgrade a license key to use a new software version, then you must 
also use the Automation License Manager (ALM).  

 

Note You cannot install upgrade license keys during Setup. 

 

5.1 Requirements for an Upgrade 

For upgrading a license key you need  

• Of the software version to be upgraded: 

• The CoL (Certificate of License) and the license key.  

• Of the target version (operator panel):  

• The CoL and the upgrade license key  

 

Note Please note that both the "old" license key and the upgrade itself must be stored 
on the hard disk of the computer on which the upgrade is to be made. 

 

5.2 Upgrading Using the ALM 

The procedure is described taking the example of an upgrade from WinCC V11 
Comfort to WinCC V11 Advanced.  

 

Note When you upgrade the license to a new version, the "old" license is overwritten. 

 

Table 5-1 

No. Description 

1.  Open the Automation License Manager (Windows XP Professional) 

 

Open the Automation License Manager via  

"Start > Programs > Siemens Automation > Automation License Manager".   

2.  Storage location of the license  

 

Select the option  

"View > Administration". 

 

Select the storage location in the navigation area where the license key to be 
upgraded is located.  

In this case drive "C:\".   

 

In the Object area on the right you get a display of the available licenses.  

In this example:  

• WinCC Comfort 

• WinCC Advanced Power Pack 
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No. Description 

 

 

 

Note: 

The "WinCC Advanced Power Pack" upgrade was transferred previously from 
the USB stick to the hard disk. 

3.  Execute an upgrade 

 

• In the Object area you select the license key that is to be upgraded. In this 
example the "WinCC Comfort" license. 

• Execute the menu command "License Key > Upgrade...".  
The upgrade is now made. 

 

 

4.  The old License Key has now been replaced. Now only the new license key is 
visible. 

 

In this example: 

"WinCC Advanced Combo" 

This completes the upgrade. 

 

 

 

Note If there is only one option for upgrading, then the upgrade is made without any 
other displays or prompts.  

If other upgrade options are found, the "License Key Upgrade" dialog opens.  

Select the upgrade to be made and click on the "Upgrade" button. 
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6 Tips and Tricks  

How do you repair a defective license? 

A license is deemed to be defective in the following cases: 

• If the license key can no longer be accessed in the storage location. 

• If the license key disappears when being transferred to the target drive. 

You can use the Automation License Manager to repair a defective license key. For 
this, use the "Restore" function or the "Restore Wizard" of the 
Automation License Manager.  

You must get in touch with Customer Support if you want to restore a license. More 
information on this is available in Entry ID: 772175.  

 

Note The Runtime software runs perfectly even if the license is missing or defective. 
The system displays a message at short intervals informing you of the 
unlicensed mode. 

 

Why is a license invalid after changing time zones? 

The installed license no longer functions if you switch from a time referred to a full 
hour to a time not referred to a full hour. 

Example: You switch the time zone from GMT +3:00 hours to GMT +3:30 hours. 

Remedy:  
Uninstall the license key with a time zone setting that was set before you installed 
the license key and reinstall the license key with the new time zone setting.  

Why are my license keys not recognized? 

In this case, the reason might be an upgrade license. You might have installed the 
license key, but have not yet made an upgrade. Help on this topic is available 
under "Upgrading Licenses". 

Where is the "old" license key located after an upgrade? 

If you want to upgrade an existing system, you can purchase an upgrade. When 
you make an upgrade, the existing license keys are replaced by the new 
license keys of the upgrade.  

How do you retrieve a lost license key? 

You must make sure that you have the CoL in order to receive a new License Key. 
This is evidence that you are the owner of the license in the legal sense. 

You must get in touch with Customer Support if you want to restore a license. More 
information on this is available in Entry ID: 772175.  

Can you copy licenses for backup?  

A license key cannot be copied. The copy-protection procedure used prevents the 
copying of license keys. 

 

 

 

https://support.industry.siemens.com/cs/ww/en/view/772175
https://support.industry.siemens.com/cs/ww/en/view/772175
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7 SIMATIC WinCC (TIA Portal) Options 

SIMATIC Panels, SIMATIC WinCC RT Advanced, SIMATIC WinCC RT Professional  

SIMATIC ProDiag 

– Fully integrated TIA solution for machine and plant diagnostics.  

– This saves having to program diagnostics in the CPU during the 
Engineering phase and supports troubleshooting with relevant diagnostics 
overviews and PLC code directly on the HMI without Engineering System.  

SIMATIC Logon 

– Creates a user administration on a central computer to which one/multiple 
WinCC stations can be connected via Ethernet network.  

– SIMATIC Logon checks whether a user ID has been created and whether 
the required authorizations are present each time a user logs on/off.  

– SIMATIC Logon supports the user together with the Audit option in meeting 
requirements in compliance with FDA 21 CFR Part 11 and EU178.  

 

SIMATIC WinCC Runtime Advanced and SIMATIC WinCC Runtime Professional 

SIMATIC WinCC Logging 

– Archiving of messages and process values.   

– Online evaluation on process value archives and message archives.   

– Evaluation of process value and message archives via MS standard tools 
like Excel, for example.  

SIMATIC WinCC Recipes 

– Creation and administration of data records for machine or production 
data.   

– Data record display and input via a configurable screen object distributed 
in the project via process screens.   

– Transfer of the data records to and from the controller.  

– Import/export of the data records for further processing with other tools like 
MS Excel, for example. 

 

SIMATIC Panels and SIMATIC WinCC Runtime Advanced 

SIMATIC WinCC Audit 

– Recording of operator actions in an Audit Trail.  

– Electronic signature for important production-relevant user actions.  

– Audit supports the user in meeting special quality requirements like 
production plants requiring validation in compliance with 21 CFR Part 11 
(Food and Drug Administration rule).  

– With regard to traceability in compliance with EU 175/2002 (EU directive).  

SIMATIC WinCC Sm@rtServer  

– Flexible solution for location-independent access to HMI systems. 

– Teleservicing of machines and plants via the internet/intranet.  

– Reduction of machine and plant downtimes through direct remote access.  

– Flexible solution for location-independent access to machines and plants.  
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SIMATIC WinCC Runtime Professional 

SIMATIC WinCC Data Monitor 

– Display and evaluation of current process statuses and historical data on 
Office PCs with standard tools. 

– Information can be gathered separately online during Runtime via the 
internet/intranet. 

 

WinCC Industrial Data Bridge for WinCC Runtime Professional (V13 SP1 and 
higher) 

With SIMATIC WinCC Industrial Data Bridge you can establish communication 
links between different data sources and data targets through simple 
configuration/parameterization. WinCC Industrial Data Bridge can be both 
integrated in WinCC and used independently (not in conjunction with WinCC) as 
a standalone application. 

SIMATIC Information Server 2014 SP3 

SIMATIC Information Server 2014 SP3 is an open web-based reporting system 
for interactive areas. Reports can be used in the Internet Explorer, for Excel, 
Word or PowerPoint, as well as for Adobe Reader (pdf). SIMATIC Information 
Server has access to archived process values and messages and can be 
implemented either directly in combination with WinCC / WinCC/RT 
Professional / PCS 7 OS or also with the SIMATIC Process Historian 2014. 
 
For more information about SIMATIC Information Server and the article 
numbers see SCADA System SIMATIC WinCC. 

SIMATIC Process Historian 2014 

SIMATIC Process Historian 2014 is a powerful long-term archive server solution 
that stores WinCC process values and messages in a central database. The 
system is freely scalable with regard to performance and quantity framework: It 
captures and stores data from one or multiple WinCC, WinCC/RT Professional 
and PCS 7 projects. There is no limit to the number of single stations, servers or 
redundant server pairs that can be connected. SIMATIC Process Historian is 
designed for plant-wide usage and is located below the corporate management 
level (ERP, MES). 
 
For more information about SIMATIC Process Historian and the article numbers 
see SCADA System SIMATIC WinCC. 

 

SIMATIC WinCC Redundancy 

For the configuration of a powerful, fail-safe client/server system. One 
WinCC/Redundancy package is required for each redundant server pair. 
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SIMATIC WinCC Server and SIMATIC WinCC Client 

Enables the configuration of a powerful client/server system.  

– Multiple coordinated operator stations can be operated in a common 
network with networked automation systems.  

– Client/server solution: One server supplies up to 32 connected clients with 
process and archive data, messages, screens and logs.  

SIMATIC WinCC WebNavigator 

– Operation and monitoring of plants via the internet or the company-internal 
intranet or LAN.  

– Web Client enables operation and monitoring of a running WinCC Runtime 
Professional project via an internet browser with ActiveX support.  

SIMATIC WinCC WebUX 

– Mobile operation and monitoring with commercially available mobile 
devices via the internet or the company-internal intranet or LAN.  

– Platform and browser can be used independently on HTML5-capable and 
SVG-capable data terminal equipment without installation on the client. 

 

An overview of the options is available at the following link. 

https://mall.industry.siemens.com/mall/en/WW/Catalog/Products/10092241?tree=C
atalogTree  

 

 

https://mall.industry.siemens.com/mall/en/WW/Catalog/Products/10092241?tree=CatalogTree
https://mall.industry.siemens.com/mall/en/WW/Catalog/Products/10092241?tree=CatalogTree
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